
Question No. 1

Select the figure from among the given options that can replace the question mark (?) in the following series.

Options :

1. a

2. b

3. c

4. d

5.

Answer : d

Question No. 2

NVS Audit Assistant 2022 Previous Year Paper



In the word ‘PREPARATION’, if the consonants used are arranged in the alphabetical order from left to right, then

which letter will come at the 4th place?

Options :

1. P

2. T

3. N

4. R

5.

Answer : R

Question No. 3

If H T B = Y and T = V Z C, then which of the following conclusions is correct?

Options :

1. C < T

2. V < B

3. V > Y

4. T = Y

5.

Answer : V &lt; B

Question No. 4

Which two numbers should be interchanged to make the given equation correct?

15 × 20 + 30 ÷ 10 – 12 = 163

Options :

1. 20 and 30

2. 10 and 15
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3. 20 and 12

4. 12 and 15

5.

Answer : 20 and 12

Question No. 5

Kamya and Vedika start walking from two different points. Kamya walks 14m from Point-A towards the east, then

turns right and walks 7m. Then she turns left and walks 12m to reach Point-B. Vedika walks 20m towards the west

from Point-C and then turns left and walks 7m. Then she turns right and walks 19m to reach Point-B. What is the

straight distance between Point-A and Point-C?

Options :

1. 50 m

2. 60 m

3. 65 m

4. 55 m

5.

Answer : 65 m

Question No. 6

Identify the number that does NOT belong to the following series.

46, 54, 81, 145, 270, 480

Options :

1. 480

2. 270

3. 145

4. 81

5.
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Answer : 480

Question No. 7

 ‘A & B’ means ‘A is the mother of B’

‘A @ B’ means ‘A is the husband of B’

‘A + B’ means ‘A is the wife of B’

‘A # B’ means ‘A is the son of B’

If ‘T # Q + N # F @ R & H,’ then how is N related to H?

Options :

1. Son

2. Brother

3. Maternal uncle

4. Father

5.

Answer : Brother

Question No. 8

Select the correct combination of mathematical signs that can sequentially replace the * signs and balance the

given equation.

42 * 27 * 3 * 84 * 2 * 3

Options :

1. +, –, ÷, ×, =

2. +, ÷, –, ×, =

3. ÷, ×, –, +, =

4. –, ×, +, ÷, =

5.
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Answer : –, ×, +, ÷, =

Question No. 9

What will be the approximate value of the following expression?

44.998 + 44.999 ÷ 8.997 + 7.002 – 20.0019 × 1.995 + 25.025 ÷ 5.016 = ?

Options :

1. 10

2. 12

3. 22

4. 30

5.

Answer : 22

Question No. 10

There are six persons viz. W, X, Y, Z, A and B; all are of different heights but not necessarily in the same order. X’s

height is 180 cm and he is taller than W, whose height is 172 cm but shorter than A, whose height is 194 cm. B’s

height is 155 cm and he is taller than Y, whose height is 148 cm but shorter than Z, whose height is 167 cm. W is

taller than Z.

Who is the shortest among all?

Options :

1. Y

2. X

3. W

4. Z

5.

Answer : Y
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Question No. 11

Select the alphanumeric-cluster from among the given options that can replace the question mark (?) in the

following series.

FY-7, IC-7, LG-9, OK-27, RO-31, ?

Options :

1. UT-35

2. US-105

3. US-62

4. US-155

5.

Answer : US-155

Question No. 12

Read the given statements and conclusions carefully. Assuming that the information given in the statements is true,

even if it appears to be at variance with commonly known facts, decide which of the given conclusions logically

follow(s) from the statements.

Statements:

All gems are stones. Some gems are toys. All stones are metals.

Conclusions:

I. Some metals are toys.

II. No toy is a metal.

III. All gems are metals.

Options :

1. Either conclusion II or III follows
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2. Only conclusions I and II follow

3. Only conclusions I and III follow

4. Only conclusion I follows

5.

Answer : Only conclusions I and III follow

Direction:
Read the given information and answer the following questions.

Eight friends named A to H are sitting around a circular table facing the centre. H is third to the left of C. G is to the

immediate left of E. D is second to the left of A. B is second to the right of G. H is second to the right of E.

Question No. 13

Who is sitting to the immediate right of H?

Options :

1. A

2. F

3. B

4. D

5.

Answer : F

Direction:
Read the given information and answer the following questions.

Eight friends named A to H are sitting around a circular table facing the centre. H is third to the left of C. G is to the

immediate left of E. D is second to the left of A. B is second to the right of G. H is second to the right of E.

Question No. 14

Who is sitting to the immediate left of G?

Options :
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1. C

2. F

3. D

4. A

5.

Answer : A

Direction:
Read the given information and answer the following questions.

The classes of seven musical instruments Guitar, Drum, Piano, Trumpet, Flute, Violin and Harmonica are held on

different days of a week starting on Monday and ending on Sunday. Harmonica classes are held on Wednesday.

Trumpet class is held just after Violin class. Flute class is neither held on Friday nor on Saturday. Drum is just after

Trumpet. Only two instruments’ classes are held between Guitar and Drum. Guitar is on some day after Harmonica.

Flute is just before Piano.

Question No. 15

Which classes are held on Friday? 

Options :

1. Piano

2. Trumpet

3. Violin

4. Guitar

5.

Answer : Violin

Direction:
Read the given information and answer the following questions.

The classes of seven musical instruments Guitar, Drum, Piano, Trumpet, Flute, Violin and Harmonica are held on

different days of a week starting on Monday and ending on Sunday. Harmonica classes are held on Wednesday.

Trumpet class is held just after Violin class. Flute class is neither held on Friday nor on Saturday. Drum is just after

Trumpet. Only two instruments’ classes are held between Guitar and Drum. Guitar is on some day after Harmonica.
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Flute is just before Piano.

Question No. 16

On which day is Piano class held? 

Options :

1. Saturday

2. Sunday

3. Thursday

4. Tuesday

5.

Answer : Tuesday

Direction:
Read the given information and answer the following questions.

In the following diagram, the ‘square’ stands for ‘engineers’, the ‘pentagon’ stands for ‘tax- payers’, and the ‘circle’

stands for ‘Indians’. The numbers in the different segments show the number of persons in that segment.

Question No. 17

How many tax-payers are engineers but are NOT Indians? 

Options :

1. 18

2. 13

3. 42

4. 29
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5.

Answer : 13

Direction:
Read the given information and answer the following questions.

In the following diagram, the ‘square’ stands for ‘engineers’, the ‘pentagon’ stands for ‘tax- payers’, and the ‘circle’

stands for ‘Indians’. The numbers in the different segments show the number of persons in that segment.

Question No. 18

How many persons are Indians who are also tax-payers?

Options :

1. 25

2. 8

3. 13

4. 33

5.

Answer : 33

Direction:
Read the given information and answer the following questions.

6 7 A 8 9 5 H 3 4 A 3 E 2 B 6 5 N 8 E 6 3 U 6 2 N 3 A 4 C 3 A 1 O K 1 E 4 3 N Y A 5 6 E 4 U 7 E 8 6 E 5 E

Question No. 19

How many numbers are there in the given string of elements that are immediately followed by a vowel?
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Options :

1. 13

2. 16

3. 15

4. 14

5.

Answer : 14

Direction:
Read the given information and answer the following questions.

6 7 A 8 9 5 H 3 4 A 3 E 2 B 6 5 N 8 E 6 3 U 6 2 N 3 A 4 C 3 A 1 O K 1 E 4 3 N Y A 5 6 E 4 U 7 E 8 6 E 5 E

Question No. 20

How many vowels are there in the given string of elements that are immediately preceded by an odd number and

are immediately followed by an even number?

Options :

1. 7

2. 8

3. 6

4. 5

5.

Answer : 6

Question No. 21
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Options :

1. a

2. b

3. c

4. d

5.

Answer : d

Question No. 22

A cylindrical bucket of radius 42 cm and height 48 cm is full of water. The water is emptied into a rectangular rub of

length x cm and breath 84 cm. If the height in the tub rises by 24 cm, then what is the value of x?

(Take π =22/7)?

Options :

1. 142

2. 138

3. 110

4. 132

5.

Answer : 132

Question No. 23

A cylindrical roller made of iron is 2.4 m long. Its internal radius is 36 cm, and the thickness of iron sheet used in

making the roller is 25 cm. What is the mass (in kg) of the roller if 1 cm³ of iron has 18 g mass?
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Options :

1. 10764π

2. 10647 π

3. 14067 π

4. 10476 π

5.

Answer : 10476 π

Question No. 24

There is a road beside a river. Two friends, A and B. started their journey from place P, moved to the garden located

at another place Q and then returned to place P. A moved by swimming at a speed of 15 km/h while B sailed on a

boat at a speed of about 18 km/h. If the flow of water current is at the speed of 6 km/h, what will be the average

speed (in km/h) of the boat sailor?

Options :

1. 20

2. 15

3. 16

4. 12

5.

Answer : 16

Question No. 25

A 60-litre mixture of acid and water contains 33(1/2%)  acid. How much water (in litres) must be added to get a

mixture having 25% acid?

Options :

1. 15

2. 210
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3. 20

4. 30

5.

Answer : 20

Question No. 26

When a positive integer x is divided by 9, the remainder is 6, and when divided by 21, the remainder is 12. If the

number lies between 300 and 350, then the sum of the digits of x is:

Options :

1. 6

2. 15

3. 18

4. 12

5.

Answer : 15

Question No. 27

Options :

1. 3

2. 0

3. 2

4. 1

5.

Answer : 2

NVS Audit Assistant 2022 Previous Year Paper



Question No. 28

A boat takes half time in moving a certain distance downstream than upstream. What is the ratio between rate in

still water and rate of current ?

Options :

1. 17 : 9

2. 7: 19

3. 3 : 1

4. 37 : 19

5.

Answer : 3 : 1

Question No. 29

If the 9 digit number 89x64287y is divisible by 72, then what is the value of (3x+2y)?

Options :

1. –28

2. –2

3. 2

4. 28

5.

Answer : 28

Question No. 30

When 4546, 5398 and 6889 are divided by the greatest number m, the remainder in each case is n. What is the sum

of the digits of the value of  (2m – 3n) ?

Options :

1. 7

NVS Audit Assistant 2022 Previous Year Paper



2. 12

3. 10

4. 9

5.

Answer : 9

Question No. 31

There were 125 employees in a company. If the number of employees increases by 25, the total expenses on

refreshment increases by ₹300 per day while the average expenditure per head diminishes by 220. The original total

expenditure (in ₹) on daily refreshment is:

Options :

1. 146200

2. 156600

3. 166500

4. 126400

5.

Answer : 166500

Question No. 32

A car is available for ₹5,40,000 cash or for ₹95,520 cash down payment followed by three equal annual instalments.

If the rate of interest charged is 15% p.a., compounded yearly, then the total interest paid (in ₹) in the instalment

scheme is:

Options :

1. 1,36,539

2. 1,39,365

3. 1,39,536

4. 1,35,936

5.
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Answer : 1,39,536

Question No. 33

A and B are two stations 645 km apart. A train starts from A at 8 a.m. and travels towards B at 60 km/h. Another

train starts from B at 10a.m. and travels towards A at 45 km/h. At what time do they meet?

Options :

1. 2 p.m.

2. 5 p.m.

3. 12 noon

4. 3 p.m.

5.

Answer : 3 p.m.

Question No. 34

Two persons, A and B, are looking at an object placed on the top of a tower, from opposite sides of the pole. A is

closer to the foot of the tower by 70 m than B. If the angles of elevation of the object by A and B are 60° and 45°,

respectively, then the height (in m) of the tower (nearest to an integer) is:

(√3 = 1.73)

Options :

1. 156

2. 124

3. 142

4. 165

5.

Answer : 165

Question No. 35
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A hemispherical tank full of water is emptied by a pipe at the rate of 23.1 litres per second. How much time (in

hours) will it take to empty 3/4  th part of the tank if the internal radius of the tank is 21 m?

Options :

1. 1575/8

2. 210

3. 175/6

4. 175/2

5.

Answer : 1575/8

Question No. 36

Options :

1. 7/8

2. 3/4

3. 13/15

4. 53/60

5.

Answer : 53/60

Question No. 37

The average of n numbers is 84. If each of 75% of the numbers is increased by 6 and each of the remaining numbers

is decreased by 9, then the new average of the numbers is:

Options :

1. 81.75

2. 84
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3. 86.25

4. 88

5.

Answer : 86.25

Question No. 38

In x litres of a solution of acid and water, acid is 62.5%. When 12 litres of acid is added to the solution, the ratio of

acid and water in the resulting solution becomes 13 : 7. What is the value of x?

Options :

1. 148

2. 186

3. 184

4. 168

5.

Answer : 168

Question No. 39

The lateral surface (in cm²) of a right prism 16 cm high standing on an isosceles triangle, each of whose equal sides

is 12 cm and the other side is 16 cm, is:

Options :

1. 480

2. 630

3. 360

4. 640

5.

Answer : 640
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Question No. 40

From the top of hill which is 200m high the angle of depression of the top and the bottom of a pole are 300 and

600 respectively. Find the height of pole and its distance from the hill.

Options :

1. 139.33m

2. 103.33m

3. 123.33m

4. 133.33m

5.

Answer : 133.33m

Direction:
Read the given information and answer the questions that follows.

An item costs for 25,000. The marked price of the item is 25% above the cost price. Dealer A bought the item from

its manufacturing company at a 30% discount on the marked price and sold it by giving a 15% discount on the

marked price. Dealer B bought the same item from the same manufacturing company at a 20% discount on the

marked price and sold it by giving a 25% discount on the marked price. Suppose dealer C bought the same item at a

25% discount on the marked price and sold by giving two successive discounts of 10% and p%, respectively, on the

marked price so that he will get a 2% profit in the deal. The same item is available in installment plan also. A

customer can buy the item by giving ₹4,800 cash down payment followed by 2 equal annual installments of 13,225.

The dealer charged compound interest at 15% p.a.

Question No. 41

What is the profit/loss percentage obtained by dealer B?

Options :

1. Profit of 7.5%

2. Profit of 12%

3. Loss of 6.25%
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4. Loss of 8.5%

5.

Answer : Loss of 6.25%

Direction:
Read the given information and answer the questions that follows.

An item costs for 25,000. The marked price of the item is 25% above the cost price. Dealer A bought the item from

its manufacturing company at a 30% discount on the marked price and sold it by giving a 15% discount on the

marked price. Dealer B bought the same item from the same manufacturing company at a 20% discount on the

marked price and sold it by giving a 25% discount on the marked price. Suppose dealer C bought the same item at a

25% discount on the marked price and sold by giving two successive discounts of 10% and p%, respectively, on the

marked price so that he will get a 2% profit in the deal. The same item is available in installment plan also. A

customer can buy the item by giving ₹4,800 cash down payment followed by 2 equal annual installments of 13,225.

The dealer charged compound interest at 15% p.a.

Question No. 42

What is the total profit/loss earned by dealer A and B?

Options :

1. Loss of ₹1,200

2. Profit of ₹1.500

3. Loss of ₹1,480

4. Profit of ₹3,125

5.

Answer : Profit of ₹3,125

Direction:
Read the given information and answer the questions that follows.

An item costs for 25,000. The marked price of the item is 25% above the cost price. Dealer A bought the item from

its manufacturing company at a 30% discount on the marked price and sold it by giving a 15% discount on the

marked price. Dealer B bought the same item from the same manufacturing company at a 20% discount on the

marked price and sold it by giving a 25% discount on the marked price. Suppose dealer C bought the same item at a
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25% discount on the marked price and sold by giving two successive discounts of 10% and p%, respectively, on the

marked price so that he will get a 2% profit in the deal. The same item is available in installment plan also. A

customer can buy the item by giving ₹4,800 cash down payment followed by 2 equal annual installments of 13,225.

The dealer charged compound interest at 15% p.a.

Question No. 43

For dealer C, what is the value of p?

Options :

1. 10

2. 9

3. 15

4. 12

5.

Answer : 15

Direction:
Read the given information and answer the questions that follows.

An item costs for 25,000. The marked price of the item is 25% above the cost price. Dealer A bought the item from

its manufacturing company at a 30% discount on the marked price and sold it by giving a 15% discount on the

marked price. Dealer B bought the same item from the same manufacturing company at a 20% discount on the

marked price and sold it by giving a 25% discount on the marked price. Suppose dealer C bought the same item at a

25% discount on the marked price and sold by giving two successive discounts of 10% and p%, respectively, on the

marked price so that he will get a 2% profit in the deal. The same item is available in installment plan also. A

customer can buy the item by giving ₹4,800 cash down payment followed by 2 equal annual installments of 13,225.

The dealer charged compound interest at 15% p.a.

Question No. 44

By default if dealer C gave a discount of 12% instead of 15% then what will be the %  change in  sold articles after

the discount. (Calculate approx value)
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Options :

1. 9.4%

2. 0.63%

3. 10.5%

4. 8.6%

5.

Answer : 0.63%

Direction:
Read the given information and answer the questions that follows.

A, B and C started a business with their capitals in the ratio of  (3/8) : (1/2) : (3/4). After 6 months, A increased his

capital by 50%, B reduced his capital by 25% and C reduced his capital by one-third. After 1 year till the end of the

second year, if A reduced his capital by 50%, B increased his capital by 25% and C increased his capital by 50%.

Question No. 45

After the second year, what was the ratio of A:B :C?

Options :

1. 7 : 3 : 8

2. 7 : 8 : 3

3. 3 : 8 : 7

4. 3 : 6 : 10

5.

Answer : 3 : 6 : 10

Direction:
Read the given information and answer the questions that follows.

A, B and C started a business with their capitals in the ratio of  (3/8) : (1/2) : (3/4). After 6 months, A increased his

capital by 50%, B reduced his capital by 25% and C reduced his capital by one-third. After 1 year till the end of the

second year, if A reduced his capital by 50%, B increased his capital by 25% and C increased his capital by 50%.
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Question No. 46

At the end of a year, B's share in the profit was ₹1,07,820. What was the share of C (in ₹) in the profit?

Options :

1. 1,45,020

2. 1,05,400

3. 1,79,700

4. 1,45,000

5.

Answer : 1,79,700

Direction:
Read the given information and answer the questions that follows.

A, B and C started a business with their capitals in the ratio of  (3/8) : (1/2) : (3/4). After 6 months, A increased his

capital by 50%, B reduced his capital by 25% and C reduced his capital by one-third. After 1 year till the end of the

second year, if A reduced his capital by 50%, B increased his capital by 25% and C increased his capital by 50%.

Question No. 47

What is the ratio of A : B: C after 1 year?

Options :

1. 15 : 14 : 20

2. 16 : 14 : 15

3. 15 : 20 : 14

4. 16 : 15 : 14

5.

Answer : 15 : 14 : 20

Direction:
Read the given information and answer the questions that follows.
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For doing a certain work, A is 60% more efficient than B, and B is 10% less efficient than C. C alone can complete

the same work in 36 hours. They started the work together.

Question No. 48

If A and B work together for 8 days, then how long (in days) will C alone take to complete the remaining work?

Options :

1. 16.24

2. 14.62

3. 17.28

4. 19.64

5.

Answer : 17.28

Direction:
Read the given information and answer the questions that follows.

For doing a certain work, A is 60% more efficient than B, and B is 10% less efficient than C. C alone can complete

the same work in 36 hours. They started the work together.

Question No. 49

In how many days was the entire work completed?

Options :

1. 9 (130/167)

2. 15 (130/167)

3. 13 (130/167)

4. 10 (130/167)

5.

Answer : 10 (130/167)

Direction:
Read the given information and answer the questions that follows.
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For doing a certain work, A is 60% more efficient than B, and B is 10% less efficient than C. C alone can complete

the same work in 36 hours. They started the work together.

Question No. 50

If A and B left the work 2 days and 5 days, respectively, before the completion of the work, then in how many days

(approximately) will the work be completed?

Options :

1. 18

2. 13

3. 14

4. 12

5.

Answer : 13

Question No. 51

Select the most appropriate option to fill in the blank.

You will not be able to get the music award ______ you do not practice regularly.

Options :

1. if

2. except

3. unless

4. whether

5.

Answer : if

Question No. 52

Select the most appropriate synonym of the bold word.
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Investment fraud is becoming rampant here with an average of two cases per day being registered with the police.

Options :

1. verified

2. curbed

3. widespread

4. checked

5.

Answer : widespread

Question No. 53

Select the most appropriate ANTONYM of the bold word.

Don’t make frivolous remarks about the article without going through it completely.

Options :

1. Serious

2. Superficial

3. Shallow

4. Slight

5.

Answer : Serious

Question No. 54

Select the most appropriate option to fill in the blank.

Vikas had put his mobile ______ on the table but he couldn’t find it.

Options :

1. nowhere

2. wherever
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3. somewhere

4. anywhere

5.

Answer : somewhere

Question No. 55

Select the most appropriate option to complete the given proverb.

A leopard doesn’t ______.

Options :

1. change its spots

2. attack till it is hungry

3. run as fast as an antelope

4. spare a weaker animal

5.

Answer : change its spots

Question No. 56

Select the most appropriate option to fill in the blank.

Durable electronic devices are now being manufactured ______1 India according ______2 standards of

sustainability and efficiency.

Options :

1. from; at

2. on; in

3. in; to

4. through; for

5.

Answer : in; to
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Question No. 57

Select the most appropriate idiom to fill in the blank.

“You need to ______ for quality control,” the marketing head told the manufacturing department.

Options :

1. raise the bar

2. be over the moon

3. go back to square one

4. rock the boat

5.

Answer : raise the bar

Direction:
Read the given passage and answer the questions that follow.

Studies have linked poor mental health to news exposure during negative and traumatic events such as terrorist

attacks or natural disasters; the more news a person consumes during and after these events, the more likely he is

to suffer from depression, stress and anxiety. For example, a 2014 study surveyed 4,675 Americans in the weeks

following the Boston Marathon bombings and collected data on how much media they consumed.

Participants who engaged with more than six hours of media coverage per day were nine times more likely to also

experience symptoms of high acute stress than those who only watched a minimal amount of news.

Research like this helps us to understand how bad news can affect our mental health, but one of the study's

authors said that 2020 is difficult to compare to other events because of the sheer volume of negative stories. This

year's exceptional slurry of bad news makes it hard to tell if the effects are magnified or not, but that is something

that future studies will hopefully elucidate. "We've had so much news from Covid-19 and the economic breakdown

to the reckoning with racial injustice combined with hurricanes and firestorms," said Roxane Cohen Silver, a

research psychologist at the University of California, Irvine. "It's clear the stress of the election has added to all this."

Question No. 58

This passage is mainly about:
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Options :

1. the stress of elections

2. environmental disasters and their influence on human lives

3. the impact of negative stories on the mind

4. racial discrimination an its impact

5.

Answer : the impact of negative stories on the mind

Direction:
Read the given passage and answer the questions that follow.

Studies have linked poor mental health to news exposure during negative and traumatic events such as terrorist

attacks or natural disasters; the more news a person consumes during and after these events, the more likely he is

to suffer from depression, stress and anxiety. For example, a 2014 study surveyed 4,675 Americans in the weeks

following the Boston Marathon bombings and collected data on how much media they consumed.

Participants who engaged with more than six hours of media coverage per day were nine times more likely to also

experience symptoms of high acute stress than those who only watched a minimal amount of news.

Research like this helps us to understand how bad news can affect our mental health, but one of the study's

authors said that 2020 is difficult to compare to other events because of the sheer volume of negative stories. This

year's exceptional slurry of bad news makes it hard to tell if the effects are magnified or not, but that is something

that future studies will hopefully elucidate. "We've had so much news from Covid-19 and the economic breakdown

to the reckoning with racial injustice combined with hurricanes and firestorms," said Roxane Cohen Silver, a

research psychologist at the University of California, Irvine. "It's clear the stress of the election has added to all this."

Question No. 59

Which of the following stories, according to the researcher, could also have added to stress in 2020?

Options :

1. Elections

2. Terrorist attacks

3. Covid-19
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4. Hurricanes

5.

Answer : Elections

Direction:
Read the given passage and answer the questions that follow.

Studies have linked poor mental health to news exposure during negative and traumatic events such as terrorist

attacks or natural disasters; the more news a person consumes during and after these events, the more likely he is

to suffer from depression, stress and anxiety. For example, a 2014 study surveyed 4,675 Americans in the weeks

following the Boston Marathon bombings and collected data on how much media they consumed.

Participants who engaged with more than six hours of media coverage per day were nine times more likely to also

experience symptoms of high acute stress than those who only watched a minimal amount of news.

Research like this helps us to understand how bad news can affect our mental health, but one of the study's

authors said that 2020 is difficult to compare to other events because of the sheer volume of negative stories. This

year's exceptional slurry of bad news makes it hard to tell if the effects are magnified or not, but that is something

that future studies will hopefully elucidate. "We've had so much news from Covid-19 and the economic breakdown

to the reckoning with racial injustice combined with hurricanes and firestorms," said Roxane Cohen Silver, a

research psychologist at the University of California, Irvine. "It's clear the stress of the election has added to all this."

Question No. 60

Which of the following is true according to the passage?

Options :

1. Watching news about bombings and mass violence for a few hours has no impact on mental health.

2. Exposure to six hours of media reporting negative news is nine times more mentally disastrous.

3. In the aftermath of Covid-19, all other disasters appear scary.

4. Future studies are required to understand the impact of racial discrimination.

5.

Answer : Exposure to six hours of media reporting negative news is nine times more mentally disastrous.
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Question No. 61

'?? लड़कों ने अमरूद तोड़कर खाए।' - वाक्य में ???? ??????? से बना शब्द विशेषण के किस भेद का उदाहरण है?

Options :

1. सार्वनामिक

2. परिमाणवाचक

3. गुणवाचक

4. संख्यावाचक

5.

Answer : सार्वनामिक

Question No. 62

'दर्जी की सुई, कभी तागे में कभी टाट में' - लोकोक्ति का सही अर्थ पहचानें।

Options :

1. थककर विश्राम करना

2. एक से बढ़कर दूसरा चालाक

3. फिर फिर वही दशा

4. हर परिस्थिति में सहनशीलता बनाए रखना

5.

Answer : हर परिस्थिति में सहनशीलता बनाए रखना

Question No. 63

'बखिया उधेड़ना' मुहावरे का सही अर्थ पहचानें।

Options :

1. आदर न करना

2. प्रभावहीन धमकी

3. सरल काम
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4. भेद खोलना

5.

Answer : भेद खोलना

Question No. 64

'बखेड़ा' का पर्यायवाची नहीं है-

Options :

1. उत्पत्ति

2. उपद्रव

3. उत्पात

4. ऊधम

5.

Answer : उत्पत्ति

Question No. 65

'सकाम' का विलोम है-

Options :

1. निष्क्रिय

2. निष्काम

3. अक्षम

4. अप्रिय

5.

Answer : निष्काम

Question No. 66

निम्नलिखित में से कौन-सा विकल्प तुलना वाचक संबंधबोधक अव्यय का उदाहरण नहीं है?
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Options :

1. अपेक्षा

2. आगे

3. सामने

4. मात्र

5.

Answer : मात्र

Question No. 67

'वर्षा रुके तो मैं जाऊँ।' वाक्य में भविष्य काल के किस भेद की क्रिया का प्रयोग हुआ है?

Options :

1. सामान्य भविष्य

2. पूर्ण भविष्य

3. हेतुहेतुमद् भविष्य

4. संभाव्य भविष्य

5.

Answer : हेतुहेतुमद् भविष्य

Direction:
?????????? ??????? ?? ???? ?????? ?? ????? ?????-

अपने देश के तरुण साहित्यकारों से मेरा अनुरोध है कि वे अपने देश को उसके समस्त गुण-दोषों के साथ देखें और ऐसे साहित्य की सृष्टि करें, जो

इस जीर्ण देश में ऐसे नवीन अमृत का संचार करे कि वह एक दृढचेता व्यक्ति की भाँति संसार से घृणा और अन्याय को मिटा देने के लिए उठ खड़ा

हो। हमारे युवकों और युवतियों में भविष्य को अपने अनुकूल बना लेने का दृढ़ संकल्प होना चाहिए। भय कहीं नहीं है। अपने ऊपर अश्रद्धा ही

हमारा सबसे बड़ा भय का हेतु है। आत्मविश्वास से बढ़कर हमारे पास दूसरा अस्त्र नहीं है और भारतवर्ष यदि आत्मविश्वासी बनता है तो यह

कोई निरा स्वप्न नहीं है। सचमुच ही भारतवर्ष की परंपरा महान है, इसके निवासियों में शौर्य है, यहाँ की भूमि रत्नप्रसू है, यहाँ का ज्ञान-

विज्ञान अतुलनीय है। केवल इस देश को अपने प्रति आस्थावान बनाना है।

Question No. 68

लेखक के अनुसार भारतवर्ष के निवासियों में किसकी कमी है?
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Options :

1. संकल्प की

2. शौर्य की

3. जान की

4. अपने प्रति आस्था की

5.

Answer : अपने प्रति आस्था की

Direction:
?????????? ??????? ?? ???? ?????? ?? ????? ?????-

अपने देश के तरुण साहित्यकारों से मेरा अनुरोध है कि वे अपने देश को उसके समस्त गुण-दोषों के साथ देखें और ऐसे साहित्य की सृष्टि करें, जो

इस जीर्ण देश में ऐसे नवीन अमृत का संचार करे कि वह एक दृढचेता व्यक्ति की भाँति संसार से घृणा और अन्याय को मिटा देने के लिए उठ खड़ा

हो। हमारे युवकों और युवतियों में भविष्य को अपने अनुकूल बना लेने का दृढ़ संकल्प होना चाहिए। भय कहीं नहीं है। अपने ऊपर अश्रद्धा ही

हमारा सबसे बड़ा भय का हेतु है। आत्मविश्वास से बढ़कर हमारे पास दूसरा अस्त्र नहीं है और भारतवर्ष यदि आत्मविश्वासी बनता है तो यह

कोई निरा स्वप्न नहीं है। सचमुच ही भारतवर्ष की परंपरा महान है, इसके निवासियों में शौर्य है, यहाँ की भूमि रत्नप्रसू है, यहाँ का ज्ञान-

विज्ञान अतुलनीय है। केवल इस देश को अपने प्रति आस्थावान बनाना है।

Question No. 69

लेखक भय का क्या कारण बताते हैं?

Options :

1. अपने ऊपर अश्रद्धा

2. देश की स्थिति

3. अन्याय

4. देश के गुण-दोष

5.

Answer : अपने ऊपर अश्रद्धा

Direction:
?????????? ??????? ?? ???? ?????? ?? ????? ?????-
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अपने देश के तरुण साहित्यकारों से मेरा अनुरोध है कि वे अपने देश को उसके समस्त गुण-दोषों के साथ देखें और ऐसे साहित्य की सृष्टि करें, जो

इस जीर्ण देश में ऐसे नवीन अमृत का संचार करे कि वह एक दृढचेता व्यक्ति की भाँति संसार से घृणा और अन्याय को मिटा देने के लिए उठ खड़ा

हो। हमारे युवकों और युवतियों में भविष्य को अपने अनुकूल बना लेने का दृढ़ संकल्प होना चाहिए। भय कहीं नहीं है। अपने ऊपर अश्रद्धा ही

हमारा सबसे बड़ा भय का हेतु है। आत्मविश्वास से बढ़कर हमारे पास दूसरा अस्त्र नहीं है और भारतवर्ष यदि आत्मविश्वासी बनता है तो यह

कोई निरा स्वप्न नहीं है। सचमुच ही भारतवर्ष की परंपरा महान है, इसके निवासियों में शौर्य है, यहाँ की भूमि रत्नप्रसू है, यहाँ का ज्ञान-

विज्ञान अतुलनीय है। केवल इस देश को अपने प्रति आस्थावान बनाना है।

Question No. 70

लेखक के अनुसार सबसे बड़ा अस्त्र क्या है?

Options :

1. आत्मविश्वास

2. शिक्षा

3. दृढ संकल्प

4. शौर्य

5.

Answer : आत्मविश्वास

Question No. 71

Which of the following rivers does NOT have its origin in the Indian state of Rajasthan?

Options :

1. Banas River

2. Mahi River

3. Luni River

4. Sabarmati River

5.

Answer : Mahi River

Question No. 72
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Who was crowned the champion of the 2021 US Open men’s singles?

Options :

1. Daniil Medvedev

2. Novak Djokovic

3. Rafael Nadal

4. Roger Federer

5.

Answer : Daniil Medvedev

Question No. 73

Who acted as the President after the death of Fakhruddin Ali Ahmed until a new President was elected?

Options :

1. Giani Zail Singh

2. Varahagiri Venkata Giri

3. Zakir Husain Khan

4. Basappa Danappa Jatti

5.

Answer : Basappa Danappa Jatti

Question No. 74

Which of the following is a scheme for formal school education and skilling of school dropouts for minorities?

Options :

1. Nai Roshni

2. Nai Manzil

3. Nai Udaan

4. Naya Savera

5.
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Answer : Nai Manzil

Question No. 75

In which year was Mahatma Gandhi to spend his time in Champaran, seeking to obtain for the peasant security of

tenure as well as the freedom to cultivate the crops of their choice?

Options :

1. 1915

2. 1916

3. 1918

4. 1917

5.

Answer : 1917

Question No. 76

Which of the following is NOT correctly matched according to the plants and the total number of chromosomes

they have?

Options :

1. Sugarcane - 54

2. Wheat - 42

3. Potato - 48

4. Sorghum - 20

5.

Answer : Sugarcane - 54

Question No. 77

RBI publishes figures for four alternative measures of money supply, viz. M1, M2, M3 and M4. Among these, which

are known as Narrow money?
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Options :

1. M1 and M3

2. M2 and M3

3. M3 and M4

4. M1 and M2

5.

Answer : M1 and M2

Direction:
Read the following paragraph to understand the context information and answer the following question/s related
with given context.

Mohiniattam or Mohiniyattam is an Indian classical dance form of South India. It is a dance of feminine grace and it

is a solo recital by women. The name of this classical dance comes from the words Mohini - a historical enchantress

avatar. The meaning of attam is graceful body movement. This dance is based on the ancient Hindu Sanskrit text on

performance arts. This dance is performed by the maidens who devoted herself in the temples through his dance

and music. This dance also has natural themes and many folk tales.

Question No. 78

Who among the following are present-day exponents of the dance mentioned in the passage?

Options :

1. Mani Damodara Chakyar and Guru Chandrasekharan

2. Rohini Bhate and Roshan Kumari

3. Sunanda Nair and Smitha Rajan

4. Elam Endira Devi and Yumlembam Gambhini Devi

5.

Answer : Sunanda Nair and Smitha Rajan

Direction:
Read the following paragraph to understand the context information and answer the following question/s related
with given context.
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Mohiniattam or Mohiniyattam is an Indian classical dance form of South India. It is a dance of feminine grace and it

is a solo recital by women. The name of this classical dance comes from the words Mohini - a historical enchantress

avatar. The meaning of attam is graceful body movement. This dance is based on the ancient Hindu Sanskrit text on

performance arts. This dance is performed by the maidens who devoted herself in the temples through his dance

and music. This dance also has natural themes and many folk tales.

Question No. 79

The classical dance mentioned in the passage used to be performed by Devadasis (temple dancers) in temples,

during the rule of the ______ from 9 to 12 CE.

Options :

1. Rashtrakuta kings

2. Chalukya kings

3. Pallava kings

4. Chera kings

5.

Answer : Chera kings

Direction:
Read the following paragraph to understand the context information and answer the following question/s related
with given context.

Mohiniattam or Mohiniyattam is an Indian classical dance form of South India. It is a dance of feminine grace and it

is a solo recital by women. The name of this classical dance comes from the words Mohini - a historical enchantress

avatar. The meaning of attam is graceful body movement. This dance is based on the ancient Hindu Sanskrit text on

performance arts. This dance is performed by the maidens who devoted herself in the temples through his dance

and music. This dance also has natural themes and many folk tales.

Question No. 80

The dance form mentioned in the passage has love and devotion to God as its major themes, with usually ______.

Options :
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1. Goddess Durga

2. Lord Vishnu

3. Lord Brahma

4. Lord Shiva

5.

Answer : Lord Vishnu

Question No. 81

In MS Word 2010, paragraph formatting is used for which of the following?

(i) Aligning

(ii) Spacing

(iii) Indenting

(iv) Adding borders

Options :

1. ii, iii and iv

2. Only i

3. i, ii, and iii

4. i, ii, iii and iv

5.

Answer : i, ii, iii and iv

Question No. 82

Which of the following input devices is used for kiosks?

Options :

1. GPS

2. Sound card
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3. Optical character reader

4. Touchscreen

5.

Answer : Touchscreen

Question No. 83

Which of the following elements together make a theme for a presentation in MS PowerPoint 2010?

(i) Colours

(ii) Fonts

(iii) Backgrounds

(iv) Effects

Options :

1. ii, iii and iv

2. i, ii, iii and iv

3. i, ii and iii

4. ii and iv

5.

Answer : i, ii, iii and iv

Question No. 84

Which of the following paths is INCORRECT with respect to MS PowerPoint 2010?

Options :

1. Insert > Media > Video

2. Insert > Illustrations > SmartArt

3. Insert > Images > Pictures > Online Pictures

4. Insert > Media > Screenshot
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5.

Answer : Insert &gt; Media &gt; Screenshot

Question No. 85

Which of the following indicates an active cell in MS Excel 2010?

Options :

1. A blinking border

2. A dotted border

3. Bolder gridlines

4. A shaded cell

5.

Answer : Bolder gridlines

Question No. 86

The classification of five generations is based on which of the following factors?

(i) Technology

(ii) Speed

(iii) Storage

(iv) Cost

Options :

1. i, ii and iii

2. Only ii

3. Only iv

4. i, ii, iii and iv

5.

Answer : i, ii, iii and iv
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Question No. 87

Which of the following was the basic component of the first-generation computer?

Options :

1. Transistors and diodes

2. Vacuum tubes

3. Integrated circuits

4. Microprocessors

5.

Answer : Vacuum tubes

Direction:
Read the following paragraph to understand the context information and answer the following question/s related
with given context.

Computer can be programmed to solve problems or complete task. A computer is an electronic device that

processes raw data to give information as output. The concept of generating output information from the input

data is referred to as input-process-output model.

Input – all computers accept inputs from the user via an input device like keyboard. Any characters, word, text,

sound, images, document, etc. can be input data.

Process – it determines what the computer does with the input. For this, it performs some action on the data by

using instructions or program given by the user of the data. The action could be an arithmetic or logic calculation,

editing, modifying a document, etc. Output – It is the result generated after the processing of data. The output may

be in the form of text, sound, image, document, etc. the computer may display the output on a monitor, send

output to the printer for printing, play the output, etc.

Storage – the input data, instructions and output are stored permanently in the secondary storage devices and can

be retrieved later.

Question No. 88
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While converting a particular amount of US Dollar to Indian Rupee in the IPO model, identify which of the following

is incorrect?

Options :

1. A calculation to convert the specified US Dollar to Indian Rupee - Process

2. A provision displaying the converted amount in Indian Rupee- Input

3. A requirement from the user for the amount of US Dollar to be converted- Input

4. A provision displaying the converted amount in Indian Rupee- Output

5.

Answer : A provision displaying the converted amount in Indian Rupee- Input

Direction:
Read the following paragraph to understand the context information and answer the following question/s related
with given context.

As we move on with the ribbon-based options in File Explorer, we come across the Sort by option. The files and

folders in your computer are arranged according to a certain sorting rule. You can change the look by simply

clicking on the Sort by option. It opens a drop-down menu with sorting options for the folder or library that is

currently open in File Explorer. If you want to apply another layer of sorting to create groups, choose the option

Group by. You will again see a drop-down option box with a set of grouping rules like Name, Date, Type, Size, Tags

and others.

You can change the appearance of your files’ look from the View tab. The View tab helps to organise all files and

folders in your PC. It provides options for sorting files how they are displayed. When you activate this tab, you will

see various groups for changing the window’s layout, files, current view, or hide certain things you see onscreen.

Within the Layout group, click one of the available options to change how your files display onscreen. You can also

preview the layout before confirming by hovering over one of the available options. To change the size of desktop

icons on your computer, select the View option and select any of the display icon options to adjust the size of

icons on your computer. Now, if you have activated the Details pane on the View tab, you can actually edit the

details that appears for a certain file. In order to edit the details that appear on the Details pane, click on the

specific detail from the pane itself. For documents, you can actually change like the ‘Title’, ‘Author’, ‘Tags’,

‘Categories’, ‘Content Status’, ‘Content size’, ‘Subject’ and ‘Comments’. But for images and photos, you can change

only the ‘Date taken’ detail and not others.

NVS Audit Assistant 2022 Previous Year Paper



Question No. 89

What is the function of the View tab in the Windows?

Options :

1. To insert a document

2. To navigate through documents

3. To delete files and folders

4. To change the display of contents layout

5.

Answer : To change the display of contents layout

Direction:
Read the following paragraph to understand the context information and answer the following question/s related
with given context.

Indentation is the increase or decrease of space between the left and right margin of a paragraph. A typical indent

is five spaces from the left or right side of the page. Alternatively referred to as a negative indent, a hanging indent

is the formatting used for the second line and subsequent lines of a citation. It is often used in a bibliography.

To create a hanging indent in Microsoft Word, first highlight the paragraph that you want to have formatted as a

hanging indented paragraph. Then, right-click the highlighted paragraph and select Paragraph. In the Indentation

section of Indents and Spacing, in the Special box, select Hanging. Alternatively, you can create hanging indents by

doing a manual return and hitting the space bar five times for each citation.

In computer programming, both tabs and spaces are valid for indentation. A tab is only one character or space.

However, a tab can be set to any value.

Depending on the program, the equivalent number of spaces used to create a tab is usually five or eight.

Question No. 90

If the value of a tab is set to 5, how many times we need to press ‘Tab’ key to indent a line 15 spaces from the left

side?

Options :
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1. Three

2. Two

3. Four

4. One

5.

Answer : Three

Question No. 91

The first auditor of a company (other than government company) is appointed by the ______ within ______ of

registration of the company by passing a valid resolution.

Options :

1. Board of Directors; 30 days

2. Board of Directors; 90 days

3. Government; 60 days

4. Share holder; 120 days

5.

Answer : Board of Directors; 30 days

Question No. 92

If 6% interest is to be allowed on a capital of ₹10,00,000, what will the adjusting entry be for this will in the books

of the partnership firm?
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Options :

1. a

2. b

3. c

4. d

5.

Answer : b

Question No. 93

ABC sports material manufacturing company budgeted the following data for the coming year:

Sales (1,00,000 units) = ₹1,00,000

Variable cost = ₹40,000

Fixed cost = ₹50,000

Find out the P/V Ratio, B.E.P and Margin of Safety.
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Options :

1. a

2. b

3. c

4. d

5.

Answer : b

Question No. 94

Which of the following statements is FALSE?

Options :

1. As per AS-9, interest is recognised on time proportionate basis.

2. Revenue recognition is mainly concerned with the timing of recognition for revenues in the profit and loss

account.
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3. Economic concept of income is based on current values.

4. Revenue should be recognised only when cash is received as per AS-9

5.

Answer : Revenue should be recognised only when cash is received as per AS-9

Question No. 95

What is the rate of Tax Deduction at Source from insurance commission?

(Commission amount is ₹20,000 and assessee is an individual)

Options :

1. 15%

2. 5%

3. 1%

4. 10%

5.

Answer : 5%

Question No. 96

What is the rate of Tax Deduction at Source for a foreign company getting dividend from units of mutual fund for

the assessment year 2021-22?

Options :

1. 20% (+SC+HEC)

2. 30% (+SC+HEC)

3. 10% (+SC+HEC)

4. 2% (+SC+HEC)

5.

Answer : 20% (+SC+HEC)
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Question No. 97

Which of the following commodities are kept outside the scope of GST?

(i) Fresh milk and pasteurised milk

(ii) Soyabeans seeds

(iii) Betel leaves

(iv) Prasadam (supplied by religious place)

Options :

1. (i) and (iii) only

2. (i) and (ii) only

3. (i) and (iv) only

4. (i), (ii), (iii) and (iv)

5.

Answer : (i), (ii), (iii) and (iv)

Question No. 98

 ______ is a system that focuses on activities as the fundamental cost objects and uses the cost of these activities

for compiling the costs of products and other cost objects.

Options :

1. Activity based costing

2. Marginal costing

3. Process costing

4. Job costing

5.

Answer : Activity based costing
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Question No. 99

Which of the following statements are required to verify trade creditors?

Statement 1: Obtain the schedule of creditors and examine it with reference to individual creditors account.

Statement 2: Inspect documents underlying purchases such as invoices, receiving reports, etc. and verify individual

creditor’s accounts balance against these documents.

Statement 3: Examine relevant records and documentation supporting the transactions to assess the validity and

accuracy of loans.

Options :

1. Statements 1, 2 and 3

2. Statements 1 and 3 only

3. Statements 1 and 2 only

4. Statements 2 and 3 only

5.

Answer : Statements 1 and 2 only

Question No. 100

For each registration, a separate GST Registration No (i.e., GSTIN) of ______ digits is allotted.

Options :

1. 10

2. 7

3. 12

4. 15

5.

Answer : 15

Question No. 101
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Which of the following statements are true or false?

Statement 1: Management of cash means management of cash inflow.

Statement 2: Cash management always attempts at minimising the cash balance.

Statement 3: In cash management, expected surplus cash, if any, is not considered at all.

Options :

1. (i) True (ii) False (iii) True

2. (i) True (ii) True (iii) False

3. (i) False (ii) True (iii) False

4. (i) True (ii) True (iii) True

5.

Answer : (i) False (ii) True (iii) False

Question No. 102

Which of the following statements is true?

Options :

1. Purchasing raw material for the factory is an example of a capital budgeting decision.

2. Capital budgeting decisions are long term decisions.

3. Capital budgeting decisions do not affect the future profitability of the firm.

4. Capital budgeting decisions are reversible in nature.

5.

Answer : Capital budgeting decisions are long term decisions.

Question No. 103

Which of the following is NOT a capital budgeting decision?

Options :
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1. Modernisation of a plant

2. Purchase of a computer

3. Purchase of raw material

4. Purchase of a machine

5.

Answer : Purchase of raw material

Question No. 104

GST Council is an apex constitution body. It was constituted by virtue of Article ______ of the Constitution of India.

Options :

1. 270(1)

2. 179(1)

3. 209(1)

4. 279A(1)

5.

Answer : 279A(1)

Question No. 105

Which of the following is NOT an example of capital receipt?

Options :

1. Amount received from the sale of an old machine.

2. Amount received from the sale of finished goods.

3. Amount received from the sale of investments.

4. Amount received from the sale of furniture.

5.

Answer : Amount received from the sale of finished goods.
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Question No. 106

Which section of the Income Tax Act, 1961, defines the term ‘Assessee’?

Options :

1. 4(7)

2. 2(9)

3. 3(7)

4. 2(7)

5.

Answer : 2(7)

Question No. 107

Appointment of the first auditor of a government company shall be made by the ______ within ______ of

registration of the company.

Options :

1. Board of Directors; 90 days

2. Comptroller Auditor General of India; 120 days

3. Comptroller Auditor General of India; 60 days

4. Comptroller Auditor General of India; 90 days

5.

Answer : Comptroller Auditor General of India; 60 days

Question No. 108

Who among the following generally maintains the Audit Notebook?

Options :

1. Director

2. Central Government
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3. Audit assistant

4. Owner of the company

5.

Answer : Audit assistant

Question No. 109

Section ______ of the Income Tax Act, 1961, defines the term ‘Assessment Year’.

Options :

1. 4(9)

2. 2(9)

3. 3(9)

4. 5(9)

5.

Answer : 2(9)

Question No. 110

Which of the following are an auditor’s objectives with regard to verification of assets?

(i)  Assets exist

(ii) Assets belong to the client

(iii) Assets are in possession of the client

(iv) Assets are not subject to undisclosed encumbrances or lien

Options :

1. (i) and (ii) only

2. (i), (ii) and (iii) only

3. (i) and (iii) only

4. (i), (ii), (iii) and (iv)
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5.

Answer : (i), (ii), (iii) and (iv)

Question No. 111

Which of the following transactions is revenue expenditure?

Options :

1. Annual repair charge on a machine ₹10,000

2. Instalment charges on a new machine ₹100

3. ₹1,00,000 spent towards purchasing an additional machine.

4. Freight and cartage on a new machine ₹1,000.

5.

Answer : Annual repair charge on a machine ₹10,000

Question No. 112

Which of the following statements is FALSE with regard to working capital management?

Options :

1. The level of working capital does not affect the smooth working of a firm.

2. In working capital management, time value of money has no relevance.

3. Gross working capital refers to the firm’s investment in all the current assets.

4. Management of working capital deals with the short-term liquidity position of the firm.

5.

Answer : The level of working capital does not affect the smooth working of a firm.

Direction:

Compute the inventory turnover ratio from the following:

Opening stock: ₹10,000

Closing stock: ₹16,000
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Material consumed: ₹91,000

Question No. 113

Options :

1. 8

2. 7

3. 9

4. 6

5.

Answer : 7

Question No. 114

Which of the following statements are true or false?

(i) Direct material cost: Cost of the material that can be directly allocated to a cost centre or a cost object in an

economically feasible way.

(ii) Direct labour cost: Cost of the wages of those workers who are readily identified or linked with a cost centre or

cost object.

(iii) Direct expenses: Expenses other than direct material and direct labour that can be identified or linked with a

cost centre or cost object.

Options :

1. (i) True (ii) False (iii) True

2. (i) True (ii) True (iii) False

3. (i) False (ii) True (iii) True

4. (i) True (ii) True (iii) True

5.

Answer : (i) True (ii) True (iii) True
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Question No. 115

Who among the following assesses is NOT liable to pay advance tax?

Options :

1. Mr. Aradhya (age 59 years) earns ₹14,00,000 from salary income and no income from his business.

2. Mr. Aradhya (age 61 years) earns ₹6,00,000 from salary income and ₹2,00,000 profit from his business.

3. Mr. Aradhya (age 45 years) earns ₹4,00,000 from salary income and ₹2,00,000 profit from his business.

4. Mr. Aradhya (age 62 years) earns ₹10,00,000 from salary income and no income from his business.

5.

Answer : Mr. Aradhya (age 62 years) earns ₹10,00,000 from salary income and no income from his business.

Question No. 116

Which of the following statements are true about input tax credit?

Statement 1: Input tax credit of SGST can be utilised for payment of SGST first and the balance for payment of IGST

on outward supply.

Statement 2: Input tax credit of UTGST can be utilised for payment of UTGST first and the balance for payment of

IGST on outward supply.

Statement 3: Input tax credit of CGST can be utilised for payment of CGST first and the balance for payment of IGST

on outward supply.

Options :

1. Statements 1 and 3 only

2. Statements 1, 2 and 3

3. Statements 1 and 2 only

4. Statements 2 and 3 only

5.

Answer : Statements 1, 2 and 3
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Question No. 117

Which of the following transactions is capital expenditure?

Options :

1. During the year ₹3,000 was spent on the repair of various machines.

2. ₹15,000 spent on repairs before using a second-hand car purchased recently.

3. Cost of annual white-washing of a building.

4. Wages paid to workers for converting raw material into finished product.

5.

Answer : ₹15,000 spent on repairs before using a second-hand car purchased recently.

Question No. 118

Application for cancellation of registration shall be submitted electronically in Form ______.

Options :

1. GST REG 16

2. GST REG 06

3. GST REG 10

4. GST REG 29

5.

Answer : GST REG 16

Direction:
Read the following paragraph to understand the context information and answer the following question/s related
with given context.

At the end of each year, all businessmen want to know how much money they made or lost throughout the year;

how much capital they have put in the firm at the end of the year; how much money they owe and to whom they

owe it; and so on. To obtain this information, it is necessary to keep a full and systematic record of all business

transactions made during the year. Bookkeeping is the methodical recording of business transactions and the

classification of such transactions into ledgers. These transactions should be summarised at the conclusion of the

period to determine the outcomes of its activity. To assist users of accounting information in making decisions, the
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summarised financial records or financial statements are interpreted and delivered to them.

Question No. 119

Select the option that correctly fills in the blanks in the following statements:

(i) Bookkeeping means ______.

(ii) Accounting starts ______.

Options :

1. (i) recording non-financial transactions in the books of account (ii) where bookkeeping ends

2. (i) recording financial transactions in the books of account (ii) where bookkeeping begins

3. (i) recording financial transactions in the books of account (ii) where bookkeeping ends.

4. (i) where accounting ends (ii) recording financial and non-financial transactions in the books of account

5.

Answer : (i) recording financial transactions in the books of account (ii) where bookkeeping ends.

Direction:
Read the following paragraph to understand the context information and answer the following question/s related
with given context.

At the end of each year, all businessmen want to know how much money they made or lost throughout the year;

how much capital they have put in the firm at the end of the year; how much money they owe and to whom they

owe it; and so on. To obtain this information, it is necessary to keep a full and systematic record of all business

transactions made during the year. Bookkeeping is the methodical recording of business transactions and the

classification of such transactions into ledgers. These transactions should be summarised at the conclusion of the

period to determine the outcomes of its activity. To assist users of accounting information in making decisions, the

summarised financial records or financial statements are interpreted and delivered to them.

Question No. 120

Which of the following is the most important information for tax authorities?

Options :
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1. Purchases during the year

2. Cash balance of the firm during the year

3. Profit generated during the year

4. Sales during the year

5.

Answer : Profit generated during the year

Direction:
Read the following paragraph to understand the context information and answer the following question/s related
with given context.

At the end of each year, all businessmen want to know how much money they made or lost throughout the year;

how much capital they have put in the firm at the end of the year; how much money they owe and to whom they

owe it; and so on. To obtain this information, it is necessary to keep a full and systematic record of all business

transactions made during the year. Bookkeeping is the methodical recording of business transactions and the

classification of such transactions into ledgers. These transactions should be summarised at the conclusion of the

period to determine the outcomes of its activity. To assist users of accounting information in making decisions, the

summarised financial records or financial statements are interpreted and delivered to them.

Question No. 121

Which of the following statements are true or false with regard to bookkeeping?

(i) The main objective of bookkeeping is to ascertain the net results and financial position of the business.

(ii) Bookkeeping includes summarising the classified transactions and then interpreting the summarised results

(iii) Bookkeeping function is performed by the senior staff and is analytical in nature.

Options :

1. Statement (i) True; Statement (ii) False; Statement (iii) True

2. Statement (i) False; Statement (ii) True; Statement (iii) False

3. Statement (i) True; Statement (ii) False; Statement (iii) False

4. Statement (i) False; Statement (ii) False; Statement (iii) False

5.
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Answer : Statement (i) False; Statement (ii) False; Statement (iii) False

Direction:
Read the following paragraph to understand the context information and answer the following question/s related
with given context.

Theory-based accounting is made up of a set of principles, concepts, norms, rules, and standards that have been

created over time. To ensure that accounting terminology has the same meaning for everyone and is more

meaningful, most accountants have agreed on a set of principles and practices that are often used while compiling

financial statements. Accounting concepts are the fundamental assumptions or ideas that are used to record

transactions and create financial statements. Business entity concept, going concern concept, accrual concept,

money measurement concept, matching concept, cost concept, accounting period concept, dual aspect concept,

and so on are some of the most widely accepted accounting concepts. Accounting conventions are statements of

practice or principles that are followed by businesses as a standard approach or procedure over time. The

conventions of full disclosure, materiality, conservatism, and consistency are just a few of the most important

accounting conventions.

Question No. 122

State the accounting conventions involved in the following statements:

(a) Accounting policies should not be changed from one period to another.

(b) Making provision for bad and doubtful debts.

Options :

1. Statement (a): Conservatism Statement (b): Consistency

2. Statement (a): Consistency Statement (b): Conservatism

3. Statement (a): Consistency Statement (b): Disclosure

4. Statement (a): Materiality Statement (b): Conservatism

5.

Answer : Statement (a): Consistency Statement (b): Conservatism

Direction:
Read the following paragraph to understand the context information and answer the following question/s related
with given context.
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Theory-based accounting is made up of a set of principles, concepts, norms, rules, and standards that have been

created over time. To ensure that accounting terminology has the same meaning for everyone and is more

meaningful, most accountants have agreed on a set of principles and practices that are often used while compiling

financial statements. Accounting concepts are the fundamental assumptions or ideas that are used to record

transactions and create financial statements. Business entity concept, going concern concept, accrual concept,

money measurement concept, matching concept, cost concept, accounting period concept, dual aspect concept,

and so on are some of the most widely accepted accounting concepts. Accounting conventions are statements of

practice or principles that are followed by businesses as a standard approach or procedure over time. The

conventions of full disclosure, materiality, conservatism, and consistency are just a few of the most important

accounting conventions.

Question No. 123

When a person starts a business investing ₹20 lakhs, it is recorded in the business by debiting the Cash account and

crediting the Capital account. Similarly, when goods are withdrawn by the proprietor, the Drawings account is

debited and the Purchase account is credited.

The above business transactions are recorded as per the ______ accounting concept.

Options :

1. going concern

2. separate accounting entity

3. realization

4. money measurement

5.

Answer : separate accounting entity

Direction:
Read the following paragraph to understand the context information and answer the following question/s related
with given context.

Theory-based accounting is made up of a set of principles, concepts, norms, rules, and standards that have been

created over time. To ensure that accounting terminology has the same meaning for everyone and is more

meaningful, most accountants have agreed on a set of principles and practices that are often used while compiling

financial statements. Accounting concepts are the fundamental assumptions or ideas that are used to record
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transactions and create financial statements. Business entity concept, going concern concept, accrual concept,

money measurement concept, matching concept, cost concept, accounting period concept, dual aspect concept,

and so on are some of the most widely accepted accounting concepts. Accounting conventions are statements of

practice or principles that are followed by businesses as a standard approach or procedure over time. The

conventions of full disclosure, materiality, conservatism, and consistency are just a few of the most important

accounting conventions.

Question No. 124

Statement:

“An accounting system is designed in such a way that both aspects i.e., changes in assets and changes in liabilities

and equity, as the case may be, of each transaction is recorded”.

Which of the following accounting concepts relates to the above statement?

Options :

1. Cost

2. Dual aspect

3. Going concern

4. Money measurement

5.

Answer : Dual aspect

Direction:
Read the following paragraph to understand the context information and answer the following question/s related
with given context.

Theory-based accounting is made up of a set of principles, concepts, norms, rules, and standards that have been

created over time. To ensure that accounting terminology has the same meaning for everyone and is more

meaningful, most accountants have agreed on a set of principles and practices that are often used while compiling

financial statements. Accounting concepts are the fundamental assumptions or ideas that are used to record

transactions and create financial statements. Business entity concept, going concern concept, accrual concept,

money measurement concept, matching concept, cost concept, accounting period concept, dual aspect concept,

and so on are some of the most widely accepted accounting concepts. Accounting conventions are statements of
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practice or principles that are followed by businesses as a standard approach or procedure over time. The

conventions of full disclosure, materiality, conservatism, and consistency are just a few of the most important

accounting conventions.

Question No. 125

According to the ______ accounting concept, revenues are credited to the period in which they are earned

whether they have been actually received or not.

Options :

1. period

2. matching

3. accrual

4. cost

5.

Answer : accrual

Direction:
Read the following paragraph to understand the context information and answer the following question/s related
with given context.

Income statements and balance sheets are traditionally included in the financial statements of businesses engaged

in trading or industrial activities. Final accounts are another name for these statements. However, if applicable, a

third statement, termed a cash flow statement, is now also prepared. A sole trader's income statement is separated

into two sections: the first section indicates gross profit or loss, and the second section shows net profit or loss. The

trading account is the first section of the income statement, and the profit & loss account is the second. The

balance sheet illustrates the assets, liabilities, and equity as of the accounting period's end. A cash flow statement,

also known as a statement of cash flows, is a financial statement in financial accounting that demonstrates how

changes in balance sheet accounts and income affect cash and cash equivalents, and divides the analysis into

operating, investing, and financing activities.

Question No. 126

Which of the following are considered as operating activities?
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(i) Cash received from trade receivable

(ii) Interest paid on debentures or long-term loans by a finance company

(iii) Sale of investment

(iv) Purchase of office building

(v) Purchase of goodwill

Options :

1. (iv) and (v)

2. (i) and (ii)

3. (i) and (iii)

4. (iii) and (ii)

5.

Answer : (i) and (ii)

Direction:
Read the following paragraph to understand the context information and answer the following question/s related
with given context.

Income statements and balance sheets are traditionally included in the financial statements of businesses engaged

in trading or industrial activities. Final accounts are another name for these statements. However, if applicable, a

third statement, termed a cash flow statement, is now also prepared. A sole trader's income statement is separated

into two sections: the first section indicates gross profit or loss, and the second section shows net profit or loss. The

trading account is the first section of the income statement, and the profit & loss account is the second. The

balance sheet illustrates the assets, liabilities, and equity as of the accounting period's end. A cash flow statement,

also known as a statement of cash flows, is a financial statement in financial accounting that demonstrates how

changes in balance sheet accounts and income affect cash and cash equivalents, and divides the analysis into

operating, investing, and financing activities.

Question No. 127

A balance sheet is a summary of the ______ accounts.
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Options :

1. Nominal and Real

2. Personal and Nominal

3. Personal and Real

4. Personal, Nominal and Real

5.

Answer : Personal and Real

Direction:
Read the following paragraph to understand the context information and answer the following question/s related
with given context.

Income statements and balance sheets are traditionally included in the financial statements of businesses engaged

in trading or industrial activities. Final accounts are another name for these statements. However, if applicable, a

third statement, termed a cash flow statement, is now also prepared. A sole trader's income statement is separated

into two sections: the first section indicates gross profit or loss, and the second section shows net profit or loss. The

trading account is the first section of the income statement, and the profit & loss account is the second. The

balance sheet illustrates the assets, liabilities, and equity as of the accounting period's end. A cash flow statement,

also known as a statement of cash flows, is a financial statement in financial accounting that demonstrates how

changes in balance sheet accounts and income affect cash and cash equivalents, and divides the analysis into

operating, investing, and financing activities.

Question No. 128

Rearrange the following assets in order of liquidity:

(i) Debtors

(ii) Goodwill

(iii) Prepaid salary

(iv) Loose tools

(v) Cash in hand
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(vi) Plant

(vii) Short-term investments

(viii) Cash at bank

(ix) Closing stock

(x) Bills receivable

Options :

1. (iv); (ix); (ii); (vii); (i); (v); (vi); (viii); (x); (iii)

2. (vi); (i); (ii); (vii); (ix); (iv); (v); (viii); (x); (iii)

3. (v); (viii); (x); (vii); (i); (ix); (iii); (iv); (vi); (ii)

4. (vi); (ix); (iii); (vii); (i); (iv); (v); (viii); (x); (ii)

5.

Answer : (v); (viii); (x); (vii); (i); (ix); (iii); (iv); (vi); (ii)

Direction:
Read the following paragraph to understand the context information and answer the following question/s related
with given context.

Income statements and balance sheets are traditionally included in the financial statements of businesses engaged

in trading or industrial activities. Final accounts are another name for these statements. However, if applicable, a

third statement, termed a cash flow statement, is now also prepared. A sole trader's income statement is separated

into two sections: the first section indicates gross profit or loss, and the second section shows net profit or loss. The

trading account is the first section of the income statement, and the profit & loss account is the second. The

balance sheet illustrates the assets, liabilities, and equity as of the accounting period's end. A cash flow statement,

also known as a statement of cash flows, is a financial statement in financial accounting that demonstrates how

changes in balance sheet accounts and income affect cash and cash equivalents, and divides the analysis into

operating, investing, and financing activities.

Question No. 129

From the following figures, calculate the operating profit:
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Net profit: ₹1,00,000

Rent received: ₹10,000

Gain on sale of machine: ₹15,000

Interest on loans: ₹20,000

Donations: ₹2,000

Options :

1. ₹79,000

2. ₹97,000

3. ₹99,000

4. ₹95,000

5.

Answer : ₹97,000

Direction:
Read the following paragraph to understand the context information and answer the following question/s related
with given context.

Income statements and balance sheets are traditionally included in the financial statements of businesses engaged

in trading or industrial activities. Final accounts are another name for these statements. However, if applicable, a

third statement, termed a cash flow statement, is now also prepared. A sole trader's income statement is separated

into two sections: the first section indicates gross profit or loss, and the second section shows net profit or loss. The

trading account is the first section of the income statement, and the profit & loss account is the second. The

balance sheet illustrates the assets, liabilities, and equity as of the accounting period's end. A cash flow statement,

also known as a statement of cash flows, is a financial statement in financial accounting that demonstrates how

changes in balance sheet accounts and income affect cash and cash equivalents, and divides the analysis into

operating, investing, and financing activities.

Question No. 130

Calculate the net sales and gross profit from the following information:
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Cost of goods sold: ₹1,00,000

Gross profit: 20% on sales

Options :

1. ₹1,25,000 & ₹25,000

2. ₹1,05,000 & ₹25,000

3. ₹1,25,000 & ₹20,000

4. ₹1,15,000 & ₹25,000

5.

Answer : ₹1,25,000 &amp; ₹25,000
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